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The April 9th Program at  6:00 P.M. 
FFG Christ Lutheran Church 

 
A reschedule of January’s cancelled program. 
 
This month’s presentation will be on the current 
version of Google Earth, an amazing map pro-
gram using satellite imaging to show all parts of 
the world right down to the backyard of your 
house. 
 
Because Google has been increasingly integrat-
ing features from Google Earth into Google 
Maps, the presentation will include an overview 
of Google Maps, which has become advanced 
to the point where some European versions take 
street view right inside some of the nearby 
buildings. 
 
Presenter will be PPCUG President Steve 
Rosenstein who makes much use of Google 
Maps in his travels. 

Winter Hours  start at 3:00 P.M. (October through March) 
Summer Hours start at 6:00 P.M. (April through September) 
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade 
 

NOTE:  Meeting Dates are now on 2nd Tuesday’s of the month  

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of the 
SIG meetings as a guest will be charged $3.00 per person for 
any or all meetings in that month. Afterwards, you are en-
couraged to become a member of the Plateau PC Users 
Group.  
Our Club cannot exist without you, the members.  
  
Membership Dues  

Our annual dues are now payable July 1st of each year.   
Annual dues are $24 per single person / $30 per family  
starting July 1, 2014.with partial years dues as follows: 

  
 
 

 
 
 
 
 
 
 

Student memberships (21 and under) are $10 annually.   
Corporate memberships are $30 a year for the first two  
memberships and $10  a year for each additional  
membership from the same company.   
Contact the PPCUG Treasurer (931) 707-3677  
for pro-rated dues of these types of memberships. 
 

BOARD OF DIRECTORS DISCLAIMER 
 

All members of the Plateau PC Users Group are willing to 
help one another in the area of advice and tutorial instruc-
tion over the phone.  If you should require more involved 
services or instruction, we have a few members who are 
very knowledgeable in several areas.  As a responsible  
consumer, it is up to you to discuss, before retaining a mem-
ber, any and ALL charges for repair services and time con-
suming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees for 
individuals for services rendered, nor the responsibility to 
intervene between members who enter into a contract 
among themselves. 
 
The GAZETTE is published using the following:  Microsoft 
Word, Microsoft Publisher, and Microsoft Windows.  The 
Gazette is the monthly newsletter of the Plateau PC Users 
Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is made 
by the PPCUG, the Gazette editorial staff or its contributing 
editors.  This extends to all losses incidental or consequen-
tial from the use or non-use of any information in any issue 
of the Gazette. 
 
All images used in the newsletter, website, blogs, class mate-
rials or handouts (“media”)  are obtained from a “free use” 
source, preferably images that have been released as “CCO 
Public Domain”. 

 
2018-2019 PPCUG, Inc. Board Members 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Linda Yates (619) 707-7339 

Past President Carl Nordeen  (931) 456-5597 

Programs Open  

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

   

Directors at Large 

Gordon Botting Richard Del Frate Barbara Duncan 

Bob Willis   

   

 

    

 SIG Leader   

Plateau Photography 
Club Workshop 

Jim Gries 
 

FGphotography-
club@gmail.com 
(331) 442-9763 

   

 
Join In 

Jul-Sep  
Annual 

Dues 

Oct-Dec  Jan-Mar Apr-Jun 

Single: $24 $18 $12 $6 

Families: 
$30 $22 $15 $7 
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Up Coming Meeting for May 2019 
 

Note: Change to Summer Hours  
 

The next General Meeting of the 
PLATEAU PC USERS GROUP 

Will be on Tuesday, May 14th at 6:00 P.M. 
at Christ  Lutheran Church 

481 Snead Drive FFG 
(corner of Snead & Lakeview Drive) 

 

Cool Tips & Sites 

How to Add a Ready-to-Use Cover Page  

to Your Word Document 
 
A great cover page draws in readers. If you use  
Microsoft Word, you’re in luck, because Word has 
ready to use cover pages Word includes some cover 
page templates you can insert and then customize a 
bit if you need a quick cover page for your docu-
ment..  
 
To find them, switch over to the “Insert” tab on 
Word’s Ribbon and then click the “Cover Page” 
button. (If your window isn’t maximized, you 
might see a “Pages” button instead. Click that to 
show the “Cover Page” button.) 

 

On the drop-down menu, click the cover page you 
want to use. 

 

You can now add your document title, subtitle, 
date, and other information, as well as change the 
design up a bit if you want.

 

 
News of the Special Interest Groups 

 

Plateau Photography Club 
  
In June 2018, the Plateau Photography and the Photo  
Editing Workshop Groups merged their monthly meetings 
into one meeting to be held on the third Thursday of each 
month, except for the months of December and February 
downstairs at the Fairfield Glade Library building (formerly 
the Multi-Purpose building), Room C, at 455 Lakeview 
Drive next to the swimming pool area. Enter the lower level 
from outside below the deck in back.  
  
Members of the PPCUG may attend at no charge; guests 
are asked to pay $3 for these workshops (the $3 fee is good 
for all meetings and workshops in the month paid). 
 
As more people take digital pictures, photo editing has be-
come a necessary and essential part of producing the final 
picture. Since over 95% percent of all pictures taken today 
are photo edited in some way, it was felt that the two topics 
should be combined in our meetings. 
  
The meetings will have monthly assignments covering a 
various categories.  Each member will be asked to bring the 
original picture taken and then explain the photo editing 
tools used to produce the final picture.  There will be dis-
cussion covering the picture itself and the tools used and 
why they were used.  Pictures with no photo editing are  
also welcomed. 
  
Each meeting will try to include short presentations on  
photography practices and/or photo editing techniques.   
 
The topics and assignments will be published in advanced 
to allow enough time for each member to plan and carry out 
their assignments.   The SIG leader is Jim Gries. at  
FGPhotographyclub@gmail.com 
  
 

 ** New look for PPCUG Website ** 
 

Visit our website at www.PPCUGinc.com. The 
Learning Center class schedule and Gazette are 
all available on our web site. 
 
Send your comments and suggestions to the  
Webmaster, Alan Baker 
Webmaster@ppcuginc.com  (931) 239-0877 
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Excel Tips 

 

One of the most frequent Excel questions I hear is some variation of “Is there a way to add the same 
header and footer (or page layout) to more than one worksheet at the same time?” The answer is easy but 
the steps are not intuitive and not even covered in most Excel books or websites. The solution is to group 
worksheets by selecting multiple sheets in a workbook. When you group worksheets you can: 

 Print a selection of sheets at the same time. 

 Enter or edit data on several worksheets at once. 

 Apply formatting, such as Page Setup options, to a selection of worksheets all at the same time. 
When you group worksheets, there is no need to repeat the same steps over and over again. 

 Move, copy, or delete a group of worksheets. 

 

How to Group Worksheets 

 

To select two or more adjacent sheets: Click the tab for the first sheet in the group. Then hold 
down [Shift] while you click the tab for the last sheet you want to select. 

To select two or more non-adjacent sheets: Click the tab for the first sheet in the group. Then hold 
down [Ctrl] while you click the tabs of the other sheets you want to select. Tabs for selected worksheets 
will display as active or white. 

To select all of the worksheets in a workbook: Right-click on any sheet tab and then left-click on Se-
lect All Sheets from the shortcut menu. 

When more than one worksheet is selected, you should see [Group] in the title bar of your Excel work-
book. 

Once you group worksheets, any action or command you do in one of the worksheets will also apply to 
all of the other worksheets in the group. This is the trick to duplicate the same header, footer, or page 
layout to a group of worksheets. Once the sheets are selected pick Insert > Header & Footer. Also, any 
text or formatting you add, such as a change to a column heading will be the same in each selected work-
sheet. When grouping, if you type data into cell B5, for example, every selected worksheet will now 
have the new data in cell B5. 

Careful! Once you are finished with the formatting and data changes you want to add to the select-
ed worksheets, be sure to un-group worksheets so you don’t accidentally change a group of worksheets 
with an edit intended only for one worksheet. 

To un-group/un-select a group of worksheets: 

 Left-click on any sheet tab 
-OR- 

 Right-click on any sheet tab and then left-click on Ungroup Sheets from the shortcut menu 

 

Important: Check the workbook title bar to verify your worksheets are no longer grouped and continue 
working with each worksheet individually. 
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Help is Only a Few Clicks Away in Word 
 

By Nancy DeMarte, 1st Vice President, Sarasota Technology User Group, FL 
December 2018 issue, STUG Monitor 
www.thestug.org / ndemarte (at) verizon.net 
 
Microsoft Word has hundreds of tools to help us create professional-looking documents, with new tools being 
added all the time. Learning how to use these tools can be frustrating. Fortunately, Word has added ways to find 
help without leaving the application.  

 
 
An example would be Format Painter, located on the Home tab on the 
left end of the Word ribbon. To learn the function of Format Painter, 
move your mouse pointer over its name on the ribbon, but don’t click. 
You will see the keyboard commands, definition, and steps in using this 
tool, as shown here. 
 
 
 
 
 

 
 
The “Tell me more” message below the definition offers more information. Click it to open a Help panel on the 
right side of the screen with more help on Format Painter. Here is a portion of the Help panel. Notice that the 
instructions have been expanded to offer even more help. 
 

(Continued on page 6) 
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Sometimes we need help with performing a task in Word, like how to add section breaks to a page. On the right 
end of the ribbon’s Tab row is a small magnifying glass followed by “Tell me what you want to do.”  Click 
this sentence and type a short phrase, like “Add section breaks.” Press Enter to open the box below.   

 
Clicking the highlighted line will take you to a gallery of page and section breaks with information about when 
to use each one. If that doesn’t answer your question, try clicking Help or See more search results for at the  
bottom of this box. 
 
Word and some other Office applications also provide help with content. If you are unsure about the spelling of 
a word, for instance, right click the word and click Smart Lookup which appears in the dropdown menu. The 
results include correct spelling, definition, synonyms, and other information about the word from Wikipedia. 

 
A new addition which provides more extensive help is the Help tab on the ribbon, which may only  be available 
in the subscription version of Office, Office 365. Here is what the Help tab offers: 

 
 
These are only some of Office Help tools located within the related application. Some older versions of Word 
may not contain all of these, which may be one reason to update to a newer version. Office 2019 is already re-
leased for the business version and will soon be available for home users. It will contain more recent tools than 
Office 2016 or prior versions. 

(Continued from page 5) 
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 Cell Phone Photography 
 

By Dick Maybach, Member, Brookdale Computer User Group, NJ 
www.bcug.com 
n2nd (at) att.net 
 
Most cell-phone camera photos have little lasting value, making their quality unimportant. However, these 
cameras are rapidly improving, and more people are using them on vacations and at important events. It 
now becomes important to take the care to make their pictures worth showing, meaning you must now  
better understand your camera and its software. The quality of your photos depends more on your photo-
graphic skills than on your camera. Good photographers take good pictures regardless of their equipment, 
and those with limited ability take poor ones regardless of how much money they spend or the tonnage of 
gear they carry. Dedicated cameras can take better pictures, but they are usually kept safe at home, while 
our cell phones are almost always with us. 
 
The first step is to recognize the limitations of cell phone cameras. 

· Their shapes make them difficult to hold steady, especially while making adjustments. 
· They have tiny sensors, making low-light photography difficult at best. 
· They reside in pockets and purses, and their exposed lenses quickly become dirty. 
· Their lenses are simple with fixed apertures and focal lengths. 

Taking good pictures requires learning to compensate for these limitations. 
 
Cell phones’ small display screens hide many sins. Develop the habit of transferring every image to a PC, 
whose large, high-resolution monitor allows you to see what you’ve captured, warts and all. Moving  
pictures to a PC also makes them available to image processing software and frees the limited storage 
space in your phone. Simple changes, such as cropping, exposure correction, and noise reduction, can 
make large differences. 
 
You hold a conventional camera against your face with both hands. The viewfinder has optics that make 
the image appear to be about a meter from your eye, and there is an adjustment to compensate for aging 
vision. Compare this to a cell phone that you hold at arm’s length where its screen if often in direct sun-
light. Clearly, the latter is subject to a lot more twitching, and using a selfie-stick makes this worse, creat-
ing blurry photos, especially in dim light. To minimize this hold your phone with both hands and release 
the shutter with a dedicated button (often one that controls the volume) rather than jabbing at the screen. 
Bend your arms so that your elbows are pressed against your waist or are resting on a table if you are sit-
ting. In dim light, rest the phone against a solid object if possible. If your near vision is limited, hold the 
camera at arm’s length to make adjustments, but pull it closer to take the picture. 
 
Tap the screen on the point where you want the camera to set its focus and exposure, otherwise it will 
make a choice. The result could be a sharply focused, well exposed shrub in the foreground and an overex-
posed blur in the background barely recognizable as the Leaning Tower of Pisa. If your subject is moving, 
set the camera to take a sequence of pictures; you’ll throw most of them away, but you may capture the 
moment you want. Also consider a sequence when photographing a group; you’ll have a better chance to 
catch everybody’s eyes open. Always squeeze the shutter button rather than jab at it; the latter jerks the 
camera. Taking a photo sequence means the timing is not important, so even here you can be gentle with 
the shutter. 
 
The best compensation for a small sensor is to have plenty of light when you take the picture. You can 
sometimes achieve this my moving so the light source is behind you; certainly try to avoid back-lit  

(Continued on page 8) 
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subjects. Another approach is to limit the exposure sensitivity, which the camera sets by adjusting its ISO, 
although not all photo apps and phones allow this,. For my phone, ISO values above a few hundred produce 
very noisy images, which even capable photo processing software can’t correct. Once you limit the ISO, you 
will find you have long exposure times, which means you now must place the camera on a solid support to 
reduce the shake. You probably also want to delay the exposure, so that it takes place a few  
seconds after you press the button, giving you time to ensure the camera is steady. Again, not all camera 
apps have this feature. 
 
Carry a clean, soft cloth or a packet of lens cleaning paper and use it often to clean the lens. Also, keep in 
mind that the lens is right at the surface of the case and has no shade. You may have to use your hand to keep 
sunlight from striking it directly. Let’s see now, you are holding the phone with one hand, operating the  
controls with another, and shading the lens with a third, while all the time trying to hold it steady. A shutter 
delay may help, but some thinking may be better. Perhaps you can stand in the shade or ask someone to cast 
a shadow on your camera. 
 
The simple lens is always set for wide-angle pictures; it achieves a telephoto effect by throwing away the 
outer portions of the image. As a result, you should avoid using the camera’s zoom feature, instead move 
closer to your subject. If you can’t, then take the picture at wide angle and throw away the unwanted portion 
of the image with processing software after you move it to your PC. This gives you more flexibility on what 
you choose in include the finished photo. Figure 1 shows a picture taken in normal (wide-angle) mode. 
 

 
Figure 1. Image in Wide-angle Mode. 
 
Figure 2 shows the same image taken using the zoom feature. The camera throws away the portion of shown 
in red; however it processes the image so that it has the same number of pixels before it stores the file. If you 
enlarge two images of the same scene, one wide-angle and one zoomed (you’ll of course have to magnify the 
wide-angle one more), you will see that both have about the same resolution, meaning the added pixels in the 
zoomed image have not improved its quality. Now do the same experiment, but instead of zooming, move 
closer to your subject, and you’ll find that the latter image does have more detail. 
 

(Continued from page 7) 
 

(Continued on page 9) 
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(Continued from page 8) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2. A Zoomed Image. 
 
Finally, be aware that unlike a dedicated camera, a cell phone camera has a fixed aperture; it controls  
exposure only by adjusting the ISO and exposure time. As a result, you have little control of the depth-of-
field. However, because a cell-phone camera has a small sensor, its depth-of-field is large, making it a 
concern only when you are very close to your subject. 
 
Most photo apps have features you can use to improve your pictures. Figure 3 shows the default display 
for Moto Camera, the photo app supplied with my Motorola phone. Note the rule-of-thirds guide lines, 
which help to compose your photo. A common technique is to locate the main subject at one of the inter-
sections. Some apps give you a choice of several such composing aids. Note also the yellow icon around 
the subject, which appears because I tapped the screen there to create a focus and exposure point. This app 
also allows you to adjust the exposure by moving the white spot around the icon circle. The other visible 
controls are (on the left) set manual or automatic mode, set the delay, control the flash, take a high-
dynamic-range photo, and (on the right) select movie, still, or panoramic mode, and switch between the 
front and back cameras. The large white button on the right is the on-screen shutter release. 
 

 
Figure 3. Moto Camera Display. 
 
Surprisingly, I found the photo app supplied with my phone (available from the Play Store as Moto Cam-
era) to be the one I use most often. It allows for adjusting the focus, white balance, shutter speed. ISO, and 
exposure, includes an exposure delay, high-dynamic-range (HDR), panoramas, and can disable the flash. 
It doesn’t allow photo sequences, and I use Open Camera for this feature. 
             
            (Continued on page 10) 
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Figure 4 shows the manual mode of Moto Camera, which allows considerable flexibility. The controls are, 
from left to right: focus, white balance, shutter speed, ISO, and exposure compensation. You move the white 
circles to make adjustments. Except for exposure compensation, a white dot at the bottom of its arc means 
that adjustment is automatic. 
 

 
Figure 4. Moto Camera in Manual Mode. 
 
Many apps offer high dynamic range (HDR) where they take several photos at different exposures and com-
bine them with the goal of showing details in both the very bright and the very dim areas. In my experience, 
it is very difficult to obtain acceptable HDR results, even with a professional camera and high-quality photo 
processing software. The results with a phone camera and its app software are often disappointing, but you 
have nothing to lose by trying. The technique won’t work on moving subjects; even leaves moving in the 
background will cause problems. Some apps, for example Open Camera (available from the Play Store), 
have a dynamic range optimization (DRO), which processes the shadow and highlight areas differently in a 
single image. This works  for moving subjects and I’ve found the improvement often approaches that using 
HDR. Open Camera will also save the individual images it combines into an HDR one, which enables you to 
use your PC processing software and perhaps get better results than with the app’s software. 
 
The capabilities of a photo app depend on the version of Android under which it runs and on what features 
the vendor has enabled. To get everything you need, you will have to experiment and probably install more 
than one photo app. 
 
We can summarize this discussion as follows. 

· Hold the camera firmly with both hands and use a dedicated button to release the shutter and squeeze 
rather than jab at it. 

· Brace your elbows and in low light rest the camera on a firm support. Consider using a shutter delay 
to reduce camera jiggle. 

· Minimize using the zoom feature but take your pictures at wide angle. 
· Always select the focus point. 
· Keep your lens clean, and shade it from direct sunlight. 
· Look at your images on a large, high-resolution monitor. 
· Experiment with camera apps to find those that best suit you and your phone. 

 
With a little care and practice you can take surprisingly high-quality photos with your cell-phone camera, 
often approaching those from dedicated cameras and far surpassing those from cameras of just a few years 
ago. 

(Continued from page 9) 
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Let’s talk about cookies 
 

By Joe Issac, Tech Talk, Central Kentucky Computer Society 
December 2018 issue, CKCS Newsletter 
www.ckcs.org 
joeisaac1234 (at) gmail.com 
 
 
NO, NOT CHOCOLATE CHIP COOKIES -- 
 
 
 
 
 
 
 
 
I’M TALKING ABOUT BROWSER COOKIES:  
Browser cookies are good, they make life easier and don't take up much space.  
 
First, let’s start with what cookies are.  
 
Cookies are simple text files that are created when you open a website. They help users navigate websites and 
perform certain functions. Cookies are used when you tell a website to “remember me,” or when you log onto a 
message board, play online games, and a bunch of other things.  
 
A cookie allows you to log onto a website without having to enter your email and password every time. They 
can only be read by the site that creates it.  
 
The main purpose of a cookie is to identify users and possibly prepare customized Web pages or to save site 
login information for you.  
 
They make surfing the web more seamless, and help websites operate more profitably and with greater  
efficiency. They record which pages you viewed, and how long the visitor stays and can help you return to a 
place you visited.  
 
Cookies may store street addresses, city and zips, passwords, credit card numbers, etc. which allows you to  
enter those with a single click and are used by web servers to know whether the user is logged in or not, and to 
which account they are logged in, like your bank or stock broker.  
 
Cookies were designed to be a reliable mechanism for websites to remember information, such as items in a 
shopping cart or to record the user's browsing activity (including clicking particular buttons, logging in, or  
recording which pages were visited by the user as far back as months or years ago). Cookies are designed to 
save you time and trouble. The chocolate chip kind are also rather tasty!  
 
 
 
 
 
There is a theory that the name for browser cookies came from the Chinese fortune cookie which usually  
contains a chunk of text, but there are arguments against that. 
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Not computer related  ** BUT. 

 

Just to keep you abreast of upcoming changes with Tennessee Driver’s License 

 

Tennesseans will soon have a new driver's license starting July 1, 2019. This license is called "Real ID," which 
will soon be issued to allow the state to meet federal standards under the REAL ID Act that primarily affects 
domestic air travel. Passed by Congress in 2005, the REAL ID Act enacted the 9/11 Commission's recommen-
dation that the Federal Government "set standards for the issuance of sources of identification, such as driver's 
licenses." The Act established minimum-security standards for state-issued driver's licenses and identification 
cards and prohibits Federal agencies from accepting for official purposes licenses and  
identification cards from states that do not meet these standards.  
 
States have made considerable progress in meeting this key recommendation of the 9/11 Commission and  
every state has a more secure driver's license today than before the passage of the Act. Currently, 4.5 million 
people have a Tennessee driver's license. As of right now, all of those are compliant with the REAL ID act, 
according to the Department of Homeland Security, but that will soon change because the roll out of the 
changes has been in stages. The next stage is the REAL ID license, which will add a gold star to the driver's 
license, which signifies it as a federal ID. Tennessee's Director of Drivers Services Michael Hogan says the 
new license will not cost more than the original one. 
 
How do REAL IDs differ from current IDs? The REAL ID is a regular license that adds a gold star. That gold 
star allows you to get through security when you are flying or allows you to enter a federal building. It desig-
nates your license as a federal form of identification and 42 other states are already issuing these licenses. If 
you do not get the REAL ID, your license is only a state license, not a federal license and when you renew 
your license, it will say "not for federal identification" 
 
You will have to have the Gold star license, passport, military ID (or other TSA approved ID) to get on a plane 
in the U.S. If you choose not to get the star, you cannot travel by air with your driver's license. Without the 
REAL ID, you also will not be able to enter a federal building starting in October 2020.  
 
How will that process work? Does everyone have to go to the DMV? When you go to renew your license you 
will have to present proper documentation -- same as what the state has always required in the past when you 
come in to TN - social security card, birth certificate/passport, two proofs of residency. If you are renewing 
your license, you will pay that normal fee when you go to get your license with a gold star. If your license is 
current, you will have to pay an $8 duplicate fee to get a license with the gold star.  
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How to Start Windows 10, 8(.1), in Safe Mode 
 

Safe Mode is a special diagnostic mode in which Windows runs with the minimum amount of features. As the 
features are limited, Windows does not load unnecessary startup items and runs only those files and drivers that 
are necessary for the basic functioning of the operating system. This allows users to remove recently installed 
programs that might be preventing Windows from starting correctly. As Windows does not start unnecessary 
programs while in Safe Mode, it can also be used to remove viruses and malware without risking the infection 
getting worse. 
 
Windows 10, Windows 8 and Windows 8.1 
The F8 key method does not work on Windows 10, Windows 8 and 8.1. Hence, getting onto Safe Mode  
requires the following steps:- 
 
If your PC is working properly: 
 
1) On the Windows Start Screen/Menu, type Advanced. 
2) Click on Advanced startup options. 
3) Under the Advanced Startup heading at the bottom of the General Settings screen, click on Restart now. 
4) Your computer will restart and you will be taken to the Advanced Startup Options menu. To easily reach 
this menu, on Windows start screen, you could choose restart while holding the Shift key. 
5) Click on Troubleshoot and then on the Advanced Options button. 
6) Now, click on Startup Settings. 
7) At the Startup Settings Screen, click on Restart. 
8) Your computer will restart to Advanced Boot options from where you can choose a Safe mode option based 
on your need. 

 
 
You can also force Windows to start in Safe mode. 
 
If your PC is not working properly: 
 
Windows monitors your PC's startup for problems and when an error is detected, it automatically takes you to 
the new Recovery mode with the message "Recovery. It looks like Windows didn't load correctly." In this case: 
 
1) Select Advanced Repair Options and then click on Troubleshoot. 
2) Click on the Advanced Options button. 
3) Now click on Startup Settings. 
4) At the Startup Settings Screen, click on Restart. 
5) Your computer will restart to Advance Boot Options from where you can choose a Safe mode option based 
on your need. 
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Why a hard drive has less storage space than promised? 
 

It has happened to most of us. We buy a new hard drive (or maybe a flash drive) with mind boggling storage 
capacity only to find that it has less space than what was mentioned on the box. Angered, we start  
cursing the manufacturer and our dealer for false marketing thinking that they should be sued for doing this. 
Hey, but have you ever wondered how they continue to do this again and again without getting into legal trou-
ble?  
 
 
 
 
 
 
 
 
 
The answer is that they are not marketing it falsely at all. Surprised? I'll explain.  
 
A manufacturer considers 1 Megabyte to be 1000 Kilobytes, 1 Gigabyte to be 1000 Megabytes, 1 Terabyte to be 
1000 Gigabytes and so on. This is correct considering that kilo means 1000 and mega means 1000000 (10^6).  
 
However, computers calculate on base 2 and to them, 1 MB is actually 1024 kilobytes, 1GB is 1024MB and 1 
TB is 1024GB. This difference in the method of computation is responsible for this "missing space." 
 
Let's take an example of a 500 GB hard disk.  
 
From a manufacturer's point of view, the 500GB will have 500*1000*1000*1000 = 500000000000 bytes. 
 
From a computer's point of view, 500GB is actually 500*1024*1024*1024 = 536870912000 bytes. 
 
So, a hard drive that promises to have 500 GB storage space will actually display 465.66GB, 536870912000-
500000000000 = 36870912000 bytes (34.34GB) less storage space when connected to a computer. 
 

 
 
 
Take a look at the table given above to see how much space is "lost" due to computers working on a base 2 sys-
tem. As you can see, with the increase in capacity of the storage device, there is an increase in the missing 
space. 
 

Space Promised Displayed on a computer Difference 

100GB 93.13GB 6.87GB 

250GB 232.83GB 17.17GB 

500GB 465.66GB 34.34GB 

1TB 931.32GB 92.68GB 

2TB 1862.64GB 
185.36GB 
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PLATEAU PC USERS GROUP, Inc. 

APPLICATION FOR MEMBERSHIP 

  

          ____ New Member                    ____ Renewing Member 
  

  

Return this application, with check for annual dues payable to "PLATEAU PC USERS GROUP." Return to the club 
Treasurer during our meeting or mail to PPCUG Treasurer. P.O. Box 3787, Crossville, TN 38557. Our annual dues are 
now payable on July 1st of each year.  Annual dues are $24 per single person / $30 per family starting 7/1/2014 with 
partial years’ dues as follows: 
 

 

 

Join In 
July-Sept 

Annual Dues 
Oct-Dec Jan-Mar Apr-June 

Single: $24 $18 $12 $6 

Families: $30 $22 $15 $7 

  

    

Date: ______________           Amount Paid: $ ____ :.00,  by Cash ___ , or    Check ( #_____________ ) 
                                                

    _____________________________________________ ________________________________  _____________________________________ 

          Last Name         First Name Family Members (if family membership) 

_______________________________________________________________________ 

           Address:  

____________________________          _____ _____________ (_____  )____________________ 

    City                        State     Zip Code Phone Number 

 
E-Mail address:  —————————————————————————————— 
 

 
I have belonged to a Computer Club before. Yes    _____    No _____ _ 
 
l have used PCs since (year):   __________     
 
I have knowledge in the following areas that I would be willing to share with club members:  
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
 
January 2019 
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Note:  Please see page #15 for the Plateau PC Users Group, Inc. Application for Membership form. 

May 2019 

Sun Mon Tue Wed Thu Fri Sat 

   1 2:00 P.M. 

PPCUG Board 
Mtg. 

2 3 4 

5 6 7 8  9 10 11 

12 13 14 6:00 P.M. 

General Mtg.  
Presentation. 
Followed By 
Q&A Session 

15 16 1:00 P.M. 

Plateau Pho-
tography Club 
Workshop 
Mtg. 

  

17 18 

19 20 21 22 23 24 25 

26 27 28 29 30 31  


